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The Universal Reader with the Talking Pointer

An Easy To Use Reading Utility

The Universal Reader is a simple, easy-to-use utility that reads to you.  It is a floating toolbar that works with almost any application.  You can use it to read your email, MS Word documents, PDF files, and any Web text.  You simply select the text you want the program to read, click on the floating toolbar, and listen while the program reads.

The Universal Reader (UR) is not a “screen reader” that reads everything to you and produces a constant chatter.  The program remains silent until you want it to read.  The floating toolbar can be set so that it is always “on top”, minimized onto the status bar,  or running behind everything as you do other activities.  The UR has a view window, which will display what is being read.  If you want to listen without reading, you can close the view window and still have the toolbar active. 

This new version of the UR has a Talking Pointer option.  This floating toolbar will allow you to read text that you cannot select or hidden text which has been “tagged” so that it is accessible to many applications.  You can program the delay, or the time you will hold the mouse over your selection before the program speaks.  

Quick Start Guide:

1.  Find ANY type of text from a computer application that you want to read.

2. Select and highlight the text.

3. Click the Read button on the floating tool bar.  Listen to the program read the text to you.

4. Click on the arrow to the right of the Options icon.   From the drop down menu select “Talking Pointer.”  

5. Position the cursor arrow over some text, a desktop shortcut or icon, links on a web page.  The program will read both visible and hidden text. 

The Universal Reader has adjustable speaking and pitch, adjustable fonts and font sizes, selectable colors for the foreground and background.  It highlights the word as it is read, and will repeat words as you type them into any application, and will echo the keys back to you as you press them.  This latter feature is a great help when you are entering data! 
E-Text Reader

Make Reading E-Text Easy

E-Text Reader is a reading tool designed to help those who have trouble reading or comprehending the printed word.  It will read electronic books (E-books) or E-text to you.  The program will read any document in Standard Text, MS Word, RTF. and HTML formats.  

The E-Text Reader will let you highlight text for notes in three different colors.   E-Text Reader has an integrated word processor that allows you to type in your own text.  It will also allow you to insert bookmarks.  If you save the bookmarks, when you open the document again you can quickly navigate from bookmark to bookmark and find where you left off reading.

E-Text Reader has adjustable speaking rate and pitch, adjustable fonts and font sizes, selectable colors for the foreground and background and a spell checker.  It will highlight and track each word as it reads either one word at a time or continuously, A Zoom feature allows you to change font size by clicking on the icon.

Quick Start Guide:

6.  *Use the Open icon to bring up the Windows Open dialog box.  

7. Select the File type you want from the drop down menu beside the Files of Type field.  Select the name  of the File you want.

8. Click on the Open button to open the document in the Reading Window.

4.  Click the Read icon and listen to the program read the document.

5. Click the Edit command.  From the drop down box, choose “Highlight Colors.”  Select the color you prefer.

6. Select a few words from the document by clicking and dragging with the mouse.  Click on the Highlight Icon.  The text will appear in the color you chose.

7. Use the Mark icon to place two or three bookmarks anywhere in the text.  Use the Prior or  Next Arrows to navigate the bookmarks.  

*If you need to clear the screen of any text, or create a new document, go to the File menu and select New.

Talking Word Processor with Word Prediction

A Word Processor that Talks Back To You

The Talking Word Processor is a full functioning word processor that can read aloud text you enter into the program.  With the Talking Word Processor you can hear the words or keys as you type, or open and read documents that you have saved.  The program has a built-in dictionary, thesaurus, and word prediction.  

The Talking Word Processor works with almost any type of existing word processor files with MS Word as the default document style.  The program provides support tools that benefit anyone who has difficulty with writing or reading tasks.    

The first time you start the Talking Word Processor the user manual will load automatically. You can let the Talking Word Processor read it to you. If you ever want load the manual again, go to the Help menu and select Load Manual. Once it is loaded, press the F6 key and it will start reading it to you

Quick Start Guide:

1. Click the New icon on the Menu Bar to open a new document.

2. Type two or three sentences into the program. 

3. To start reading, press the F6 key. 

4. To stop reading, press the F7 key.   If you press the F6 key again, the program will start reading where it left off.

5. Use the left or right arrow keys to spell out a word.

6. Hold down the CTRL key and then press the left or right arrow keys to read a word at a time.

7. Double click on a word to bring up the definition of that word from the dictionary.  

Reading options include a word view, a visible window that remains stationary on your computer screen and displays each word that is being read.  Word prediction options allow you to control the size of the font, use of an abridged or unabridged library, and the number of characters you type before the list is displayed.
Ultimate Talking Dictionary

Always Having a Dictionary a Keystroke Away

The Ultimate Talking Dictionary is a comprehensive dictionary that will read the definition of a word to you and use the word in a sentence to help you get a true understanding of the meaning.   The dictionary contains 250,000 words, including slang, jargon, and historic figures.  It has a fully integrated thesaurus for referencing synonyms and antonyms of all words.

You can use the Ultimate Talking Dictionary in several ways.  You can use it as a traditional dictionary where you type in a word and it looks it up for you.  You can set it up to run in the background and use with most other applications.  Once you have loaded the dictionary, you can activate it by pressing CTRL+F12.  Once it is active, you can press the F11 key to look up the highlighted word.  To put it back to sleep, click on the Close button or select Close from the file menu.

Quick Start Guide:

1. Type a word that you want to define in the Lookup Word field.

2. From the drop down menu beside “Look For,” select whether you want All Types, or Noun, Verb, Adjective, Adverb, Preposition, Conjunction, Pronoun, and Interjection. 

3. Listen to the program read the definitions.

4. Check the right hand column to see if there are synonyms for the word.

5. Note if there are any words or phrases in the bottom field.   If there are some, click on the tabs to see such additional information as antonyms, descriptions of the word, attributes, types, see also, similar. 

The Ultimate Talking Dictionary will allow you to do a Power Search when you only know how to spell part of the word.  It will give you a list of words with those letters.  If you misspell a word, it will “predict” the word you are trying to spell and present you with a list of potential matches to the word you are seeking.

Scan And Read Pro 

A Powerful Tool to Support Reading

Scan and Read Pro is a scanning and reading program that can take a picture of printed material you have placed on the scanner, recognize and grab the text, and read it to you.  Once Scan and Read is setup, it can be controlled with only three keys. 

The program uses the default scanner that you have assigned to your PC.  It works with any Twain compliant, USB compatible scanner.  You can scan in black and white, or in full color with images and table support.  You select one of three templates which is optimized for print in books, magazines, or other documents..   

Scan and Read includes a fully functioning word processor with spell checker, thesaurus, and word prediction.  It will create Wave and MP3 files and play MP3 files with the keyboard controlled MP3 player.

Quick Start Guide:

1.  Place a document on the scanner.

2.  Press the F5 Key or click on the Scan icon.

3. When Scan and Read says document done, run the spellchecker to help identify errors.  

4.  Press the F6 or Click on the Read icon to start reading.

5. To Stop Reading Press the F7 Key. If you press the F6 again, it will start reading where it left off.

6.  If there was an image on your document, click View.  From the drop down menu, select Image View.  You will see the picture you scanned.

Scan and Read Pro supports 12 languages including Spanish, French, German, Italian, Norwegian.  For example, to scan and read Spanish, you need to select a Spanish voice and then select Spanish from this menu to set the dictionary to recognize Spanish words.
                         Text-to-Audio

Turn Documents Into Audio Files

Text-to-Audio is a utility that can turn documents on your computer into audio files in five straightforward steps.  You can use this program to make your own “books on tape” or turn E-books into audio files which you can  listen to on your computer or with a CD or MP3 player.

To create an audio file, you first select an input file to be converted to audio.  Then you set the output path for the resulting audio file, select a voice, choose an audio file type, and create the file.  When the process is complete, you are ready to play the file using any “media player” software on your PC, or other hardware such as the CD or MP3 player.

Quick Start Guide:

1. Start Text-to-Audio.

2. Click on the Add button.

3. Select a sample file.

4. Select an output file type. If you want something different than MP3, select the desired audio file type.

5. Select a Voice if you want to use a different voice.

6. Click on the Start Icon.

When you add a file the file size will be listed on the right side of the screen. This is the number of characters in the document. Every 1,000 characters will translate into 1 minute of audio, and about 1 Megabyte of disk space. It is best to keep your audio files to an hour or less. That means if your file is greater than 60,000 characters, you will want to break it into smaller files like chapters.  If the file is too large, media players will not play it.

PDF Magic

Convert PDF Files to Accessible Formats

PDF Magic is a tool used to convert a PDF file into one of five different accessible formats including a Microsoft Word compatible file format.  This means that you do not have to have the original program that created the document to convert the file into a Word, text or html file!

PDF or “Portable Document Format” is a document format created by the Adobe Company.  Traditionally. PDF Files were only viewable through a free product from Adobe, called Adobe Acrobat Reader.  Adobe Acrobat Reader has an accessibility plug that will export text from a PDF File.

PDF Magic has a simple easy-to-use interface.  The tool bar contains large icons with pictures and captions.  The editing or formatting bar contains icons that are standard and customarily used in the industry.

Quick Start Guide:

1. Press the F4 Key or click on the Open icon.

2. Select the PDF file you want to open.  PDF Magic will load the text from the file.  It will keep the text on the correct page.

3. Once the PDF file is loaded into PDF Magic, you can save the file in a format of your choice.  If you want to save the document as a different name or different file type, click the Save As feature.  Here you can enter a new name or select a different file type.

4. If you just want to read the PDF file, press the F6 key or click on the Read icon.

If  PDF Magic encounters a PDF File that has been encrypted or protected, you will be prompted with a question asking you if you would like to remove the barriers from the PDF File.  If you select “yes”, PDF Magic will unprotect the file and you will be able to open it.  The original file is not altered.  A copy of the file is made accessible.

            OFF Limits 

  The Talking Web Browser

Off Limits is a talking web browser that was designed to give you total control and security over Internet use.  The program works under the philosophy that it is easier to manage the few sites you access on a regular basis than the millions you never visit.

Off Limits uses permission-based rules to limit access by website and time frames.  It will allow you to highlight and read web pages online, create individual profiles for multiple users, and create audio files from web pages.  The program comes with lists of safe site categories such as education and government.

When you first run Off Limits, you will be prompted to log in. The first time you log in, your password is "password".  You will want to change this as soon as you can.

The first time you run Off Limits, You will see a “User Setup Wizard". This wizard will step you through setting up all the user profiles you need. Click on the settings menu and the Setup Wizard to get to the wizard in the future.

The User Manual is built into OFF Limits. To load this manual click on the Help Menu and select the "User Manual" menu item and the manual w ill load right into the Off Limits browser.

Quick Start Guide:

1. Reading A Web Page

a. Go to the page you want to read.

b. Highlight what you want to hear.

c. Click on the Read Icon on the toolbar or press F6.

2. Where Can I go

a. To see a list of all the sites that you can go to. click on the "Where" icon on the tool bar.

b. To go to a site in the list double click it.

3. Adding A New Website (URL) Quickly

a. Type in the new website (URL) in the address box and press enter.

b. If you get the OFF Limits notification, press the F8 key.  If you are logged in as an administer (Admin), the site will be added.  If not, you will be prompted for the Admin password.

 Text Cloner Pro 

Scan Text To Work With a Screen Reader

Text Cloner is a scanning program that takes a picture of printed material you have placed on the scanner, grabs the text from it, and displays it on the screen in an accessible format. This is a powerful tool for someone who is blind.  It bridges the gap between the inaccessible physical world of print material and the accessible electronic world of digital text.  

Text Cloner Pro is designed to work with a blind user’s screen reader. Screen Readers speak text on the computer screen so that blind individuals can hear what sighted people see.  

Text Cloner Pro has three different types of scanning options:  Magazine,  Book and Other. The default is Magazine. When magazine is selected it will look for columns, glossy paper and images. This scanning style works for almost all types scanning. "Book" is optimized for novels that are text only. “Other" is used when you do not want Text Cloner Pro to look for columns. This option leaves the formatting as close to the original document as possible.

Quick Start Guide:

1. Place a printed document on the scanner. It can be crooked. sideways and even upside down. Text Cloner Pro does not care. It will figure it out.

2. Press the F5 key on the keyboard. Within a few seconds, the text that is on the document will appear on the screen in a format that screen readers can read.
Text Cloner Pro has a built-in utility that treats your scanner and printer as a copy machine.  It includes a full-featured word processor with spell checker and thesaurus and will save files in multiple formats.  It can open Daisy Formatted text documents and convert a Daisy Format to an MS Word document that you can edit.

                                                          Scan and View

Seeing It Clearly By Enlarging it

Scan and View is a very useful tool for anybody who needs materials enlarged in order to see them clearly. Scan and View allows anyone to read fine print such as contracts, bills, photographs and hand written text.

Scan and View will grab an image from your scanner and display it on your screen in 24 million colors.  Once the image is displayed, you can use the mouse or arrow keys to move around the image.  The program can rotate images 360 degrees, open and save images to your computer, and automatically straighten images it scanned in.

If you have low vision and use a Closed Circuit TV, this product will turn a standard scanner into a CCTV.  If you load this program onto a laptop with a portable scanner attached, you will always have a Closed Circuit TV with you wherever you go!

Quick Start Guide:

1. Place a document on the scanner.  Click on the scanner Icon. Within a few seconds, the image will appear on the screen.

2. If you need to rotate the image, click on the Rotate Icon until the image appears right side up on the screen.

3. Click on the “Zoom In" icon if you need to make the image larger or smaller. Click on the "Zoom In" or “Zoom Out” Icon respectively.

4. If the image appears to be crooked, Press CTRL + C to correct it and the image will automatically straighten itself.

5. If you want to reverse the Image colors, just press the F12 key.  To switch it back to the normal colors, press the F12 key again.

The program has four scanning speeds: Slow, Normal, Fast and Even Faster. The slower you scan, the clearer the image will be at the larger magnification levels.  There is an extra magnification window for detailed viewing.  Scan and View works with any USB scanner.
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